Giovanni Betti Beneventi

E-mail: gbbeneventi@arces.unibo.it ; giobettibeneventi@gmail.com

Office: Engineering faculty, ARCES lab. (Ex. 3.2 room), viale del Risorgimento 2, Bologna

Phone: +39-051-209-3773

Advanced Research Center on Electronic Systems (ARCES)

University of Bologna, Italy
Outline

- Sentaurus Tools
- TCAD simulation flow
- Starting TCAD: Sentaurus Workbench
- Sentaurus Structure Editor
- Sentaurus Device
- Output examples
- Conclusion
Outline

✓ **Sentaurus Tools**

- TCAD simulation flow
- Starting TCAD: Sentaurus Workbench
- Sentaurus Structure Editor
- Sentaurus Device
- Output examples
- Conclusion
Synopsys TCAD Sentaurus tools

- Synopsys TCAD Sentaurus is a **software suite** made by several tools (each one with its own programming language)
- The starting page of the **Synopsys TCAD manual** contains the link to the manual of each tool

---

**TCAD Sentaurus™**

<table>
<thead>
<tr>
<th>Framework</th>
<th>Process Simulation</th>
<th>Device Creation</th>
<th>Device Simulation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sentaurus Workbench</td>
<td>Sentaurus Process</td>
<td>Sentaurus Structure Editor</td>
<td>Sentaurus Device</td>
</tr>
<tr>
<td>Calibration Kit</td>
<td>Advanced Calibration for Process Simulation</td>
<td>Mesh Generation Tools</td>
<td>Advanced Calibration for Device Simulation</td>
</tr>
<tr>
<td>Impact</td>
<td>Sentaurus Interconnect</td>
<td>Sentaurus Topography 3D</td>
<td>Compact Models</td>
</tr>
<tr>
<td>Liganent</td>
<td>Sentaurus Topography</td>
<td>Sentaurus Device</td>
<td>Sentaurus Device</td>
</tr>
<tr>
<td>Optimizer</td>
<td>Electromagnetic Wave Solver</td>
<td></td>
<td>Monte Carlo Solvers</td>
</tr>
<tr>
<td>Sentaurus Data Explorer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sentaurus Visual</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tecplot SV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Utilities</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Version I-2013.12
Outline

• Sentaurus Tools

✅ *TCAD simulation flow*

• Starting TCAD: Sentaurus Workbench
• Sentaurus Structure Editor
• Sentaurus Device
• Output examples
• Conclusion
Modeling of semiconductor devices: typical flow

TCAD PROCESS SIMULATION → PROCESS EMULATION

TCAD DEVICE SIMULATION

Spice-like MODELING

COMPACT MODELING → ENABLES CIRCUIT DESIGN

Process Emulation.
Process steps are not simulated but emulated, i.e. the device structure is realized through somewhat idealized procedures that mimic real process flow. Process emulation is used for first order device analysis (e.g. targeting a device for new specs., exploring new device concepts). Process simulations can be done once a new device architecture has been optimized by means of device simulation in order to (a) investigate process non-idealities, (b) target process specs.

Compact Modeling.
Compact modeling is a methodology strictly related to TCAD. Once the physics of the device has been verified by TCAD, the device electrical characteristics can be “synthesized” by analytical functions that can be physically-based or simply behavioral. Compact modeling is needed to provide the “device model cards” to the circuit designers for circuit simulations.
Going through the DEVICE SIMULATION steps

- **Getting the device geometry and doping concentrations (from process emulation)**

- **Generating a grid (mesh) for numerical computation**

- **Solve for Poisson equations, Current continuity and Transport equations on the defined mesh for some given boundary conditions**

- **Visualizing the results (both electrical results and internal quantities)**

**Pre-processing**

**Processing**

**Post-processing**

The description of physics goes here
Outline

• Sentaurus Tools
• TCAD simulation flow
✓ Starting TCAD: Sentaurus Workbench
• Sentaurus Structure Editor
• Sentaurus Device
• Output examples
• Conclusion
Loading TCAD environment in the lab (1)

Open Sentaurus Workbench (SWB)
1. Connect Ethernet cable
2. Turn-on the laptop
3. Insert username and password
4. Type `startx`
5. Press `Alt-P`; type `terminology`
6. Connect to ARCES machine “bue” `ssh -Y bue`
7. Loading the environment variables `source .ISErc`
8. Type `swb &`; click on swb window; press `Alt-Shift-2`; press `Alt-2`

Open Sentaurus manual:
1. Press `Alt-3`; press `Alt-P`; type `terminology`
2. Type `evince TCAD/front.pdf &`; press `Alt-Shift-4`

Useful shortcuts & commands:
Select a desktop: `Alt-number`
Resize window: `Alt-dx touchpad button`
Move window: `Alt-sx touchpad button`
Get control to a terminal where some program has ben launched `CTRL-C`
Close a remote connection: `logout`
Close `startx`: `Alt-Shift-Q`
Back to login page: `CTRL-D`
Power off the pc: `Alt-Shift-Q`; `poweroff`

N.B. Italian keyboard: ~: `alt gr + i`  {}: `alt gr + ↑ + [ ]`  _: `↑-`
A few words on source .ISErc

.iserc is a configuration file stored in the home directory which contains some useful commands and settings: among the others, tells OS where finding out TCAD software installation and executables, tells OS how to get the license file and where user’s SWB projects reside. In addition, it contains:

```plaintext
setenv OMP_NUM_THREADS 4
setenv NCPUS 4
# .exe
alias swb "/sw/CAD/TCAD/I_2013.12/bin/swb"
```

max number of simultaneous threads
max number of CPUs used simultaneously
code parallelization

Set gedit as default editor

on swb window
F12
scroll down to editor and click on the symbol
select text
click inside the bar at the top and type /usr/bin/gedit
Sentaurus Workbench: general information

- It is the main tool **interface** which can be Windows-like controlled
- From Sentaurus Workbench (SWB) all the **simulation flow** can be controlled
- Simulations trees with variation of parameters in a **matrix organization** can be created
- An instance in the SWB tool is called “**Project**”
- When a project is saved, a directory is created. ASCII files containing the details of the saved project are created in the directory (in particular the `gtree.dat` file contains the details of the simulation tree)
- Essential vocabulary to understand SWB operations:
  - **Scenario**= to simplify the visualization, the whole simulation tree (the whole project) can be divided in more than one scenario (it means that one project can be divided in more trees)
  - **Tool**= one of the Sentaurus TCAD tools (e.g. sde, sdevice, inspect, etc.).
  - **Parameter**= a variable (it can be a dimension, a physical property, a logic flag..)
  - **Experiment**= a row in the simulation matrix
  - **Node**= a point of the simulation matrix. Each point of the matrix is a “node”.
    - Real node: node that can be executed (one for each tool). They are colored according to the execution status of the corresponding simulation job
    - Virtual node: node that cannot be executed
  - **Root**= part of a row (i.e. of an experiment), from a given node to the left
  - **Leave**= part of a row (i.e. of an experiment), from a given node to the right
Sentaurus Workbench: configuration and shortcuts

Project → New → Project → Configuration → Research

Research provides maximum flexibility, while Standard provides maximum level of consistency.

Edit → User Preferences → Default View Options → Show Pruned → false

To prune a node means to cancel an experiment from the simulation tree.

Scheduler → Local jobs → Maximum number of simultaneous jobs → 10

The scheduler is the software tools which organizes the execution of the simulations.

Scheduler → Local jobs → Default Nice Level → 1

The lower the Default Nice Level (1 is the minimum value) the higher the priority by which the simulation is running by the operating systems.

F5 refresh
CTRL-P node preprocessing ; CTRL-R: node running ; CTRL-T abort node execution

F6 edit parameter value in a node

F6 node explorer

F9 show/hide node number
Sentaurus Workbench: useful commands

Project → Operations → Unlock
Unlock project blocking

Parameter → Add
Add parameters

Experiments → Create Default Experiments
To start a new trees: it creates the root experiment with default values parameters

Experiments → Add New Experiment
To add a new experiment

[select a node] → Nodes → Extend Selection to Experiment → Experiments
→ Add Values
To branch the trees by adding values to a selected experiment only

[select a node] → Nodes → Extend Selection to Leaves → Nodes → Prune
To cancel a branch in the experiment tree
To use parameters, those must be placed between a pair of @ in the tools command files (see later). Example: for the BTBT (Band-to-Band-Tunneling physical model) flag to be an Sdevice variable, in the Sdevice command file BTBT must be indicated as @BTBT@

The pre-processing steps basically writes how many files how many are the project’s experiments, in each of them substituting the @BTBT@ with the value of BTBT in the node corresponding to the given experiment.

Therefore, a pre-processing step is mandatory before an execution of a simulation.

- Although we have thoroughly reviewed the most important feature, many other functionalities are available in SWB (to name a few: include Tcl code blocks, cut & paste scenario’s blocks, conformity checks): always refer to the user guide embedded in the manual front-page.
Outline

• Sentaurus Tools
• TCAD simulation flow
• Starting TCAD: Sentaurus Workbench
  ✓ *Sentaurus Structure Editor*
• Sentaurus Device
• Output examples
• Conclusion
Sentaurus Structure Editor

- Tool that can be used for process *emulation*
- It allows defining
  - device materials & geometry (1D, 2D, 3D)
  - doping
  - contacts
- Within Sentaurus Structure Editor (SDE), the meshing operation must also be performed
- Better to use it in **batch mode** to increase program flexibility and power
- Input file where to write SDE command in text form must be named *sde_dvs.cmd*
- Once SDE is run, two files are produced:
  - `nnodenumnumber_bnd.tdr` for the visualization of the produced device geometry
  - `nnodenumnumber_msh.tdr` to visualize the device geometry & the numerical mesh
- The difficult part about SDE is of course not programming in itself, but understanding and evaluating the simplification inherent to the idealized geometry drawings!
- Also the choice of the numerical mesh is sometimes not at all trivial (critical for the convergence of the numerical algorithm)

N.B. 3D TCAD simulations are available in Sentaurus and much used especially by industry (need of precise results on particular application in which the device process/geometry is usually well known). On the other hand we will deal only with 2D simulations, for the sake of simplicity.
Outline

- Sentaurus Tools
- TCAD simulation flow
- Starting TCAD: Sentaurus Workbench
- Sentaurus Structure Editor
  ✓ Sentaurus Device
- Output examples
- Conclusion
Tool that defines the partial differential equations to be solved, i.e. **it defines the physical model** (e.g. the drift-diffusion model, which consists in the Poisson equations and the current continuity equations)

**Boundary conditions** (typically bias at the electrodes) must also be defined

The **material parameters** of the physical model employed must be provided in a separate file

It is possible to perform **sweeps of the boundary conditions** in order to get device electrical characteristics

Also **parameters for the numerical solvers** implemented in the software must be defined

**Input files:**
- `sdevice_des.cmd` for physical models, boundary conditions and numerical parameters
- `sdevice.par` to enter the model material parameters

**Output files:**
- `nnodenumber_des.tdr` for the visualization of the simulated physical quantities on the domain
- `nnodenumber.plt` to visualize the device electrical characteristics

The difficult part about Sdevice is not programming in itself but understands the simplification inherent to the chosen physical models!

It is in general not trivial to understand which physical models must be included

Also the choice of material parameters and of the numerical parameters can be challenging
File naming conventions of SDE and Sdevice tools

**Sentaurus Structure Editor (SDE)**
- Command: `sde_dvs.cmd`
- "grid" file: `n@node@_msh.tdr`
- Output: `n@node@_dvs.out`

**Sentaurus Device (Sdevice)**
- Command: `sdevice_des.cmd`
- "parameter" file: `sdevice.par`
- "plot" file (internal quantities): `n@node@_des.tdr`
- "current" file (electrical characteristics): `n@node@_des.plt`
- Output: `n@node@_des.out`
The manuals: where is the description of the device physics?
Part II  Physics in Sentaurus Device

This part of the Sentaurus™ Device User Guide contains the following chapters:

Chapter 7 Electrostatic Potential and Quasi-Fermi Potentials on page 191
Chapter 8 Carrier Transport in Semiconductors on page 197
Chapter 9 Temperature Equations on page 205
Chapter 10 Boundary Conditions on page 217
Chapter 11 Transport in Metals, Organic Materials, and Disordered Media on page 239
Chapter 12 Semiconductor Band Structure on page 253
Chapter 13 Incomplete Ionization on page 279
Chapter 14 Quantization Models on page 285
Chapter 15 Mobility Models on page 309
Chapter 16 Generation–Recombination on page 377
Chapter 17 Traps and Fixed Charges on page 427
Chapter 18 Phase and State Transitions on page 447
Chapter 19 Degradation Model on page 463
Chapter 20 Organic Devices on page 487
Chapter 21 Optical Generation on page 491
Chapter 22 Radiation Models on page 605
Chapter 23 Noise, Fluctuations, and Sensitivity on page 615
Chapter 24 Tunneling on page 647
Chapter 25 Hot-Carrier Injection Models on page 667
Chapter 26 Heterostructure Device Simulation on page 693
Chapter 27 Energy-dependent Parameters on page 697
Chapter 28 Anisotropic Properties on page 707
Additional tools (1) : Tcl

- **Tool Command Language (Tcl)**
  - Commands in Tcl can be inserted in the command files of the Synopsys Sentaurus Tool
  - Tcl allows increased flexibility, providing the means of adding:
    - Conditional statements (control structures)
    - Automation of export and manipulation of computed quantities

- More information about Tcl can be found in the Sdevice manual and in the Sentaurus Data Explorer manual of Sentaurus Synopsys manual’s suite
**Additional tools (2) : PMI (1)**

- The **PMI (Physical Modeling Interfaces)** is an advanced additional tool provided in Sentaurus Sdevice to increase the flexibility of the software.
- **The PMI allows user to add its own physical models to express many physical properties.**
- However, equations cannot be changed!
- **Example.**
  - Heat equation: \(-\nabla \cdot k \nabla T = Q_j\)
    
    where \(k\) is the thermal conductivity, \(T\) is the temperature and \(Q_j\) is the Joule heating generation term (given by the scalar product of current density and electric field)
  - Heat equation cannot be modified, but the user can provide its own expression for \(k\) as a function of other predefined physical quantities.
  - User functions are written in C++
  - Functions are compiled and loaded at run-time.
Additional tools (2) : PMI (2)

• Accessible models:
  – Generation–recombination rates / Lifetime
  – Avalanche generation, i.e. ionization coefficient
  – Band gap, Band-gap narrowing, Electron affinity
  – Effective mass
  – Energy relaxation times
  – Thermal conductivity, Heat capacity
  – Optical absorption, Refractive index
  – Metal Resistivity
  – Mobility
  – … and many others
Additional tools (2) : PMI (3)

- **Physics**
  - Formulate the analytical expression of the model
  - Compute the derivatives with respect to relevant input variables

- **Coding**
  - Implement C++ model and derivatives in `modelname.C`
  - Compile run-time object using `cmi`
  - Resulting `modelname.so.arch` is architecture dependent

- **Execution**
  - Introduce the PMI path in the Sdevice `File{ }` section
  - Specify model name in `Physics{modelname}` section
  - The PMI model parameters accessible from Sdevice parameter file as : `modelname{}`
Mixed-mode simulations

• A *mixed-mode* simulation is available, meaning that in Synopsys Sentaurus it is possible to **simulate a circuit in which a device is inserted**.

• The mixed device and circuit capabilities give Sentaurus Device the ability to solve three basic types of simulation: single device, single device with a circuit netlist, and multiple devices with a circuit netlist
Outline

• Sentaurus Tools
• TCAD simulation flow
• Starting TCAD: Sentaurus Workbench
• Sentaurus Structure Editor
• Sentaurus Device
✓ Output examples
• Conclusion
Examples of simulation output

- `.tdr` files must be opened with Sentaurus Visual (Svisual)
- `.plt` files must be opened with Inspect

output of SDE simulation: geometry, mesh and doping concentration (displayed with Svisual)

output of Sdevice simulation: electrostatic potential (displayed with Svisual)

output of Sdevice: IV characteristics of a pn diode in forward bias (displayed with Inspect)
Outline

• Sentaurus Tools
• TCAD simulation flow
• Starting TCAD: Sentaurus Workbench
• Sentaurus Structure Editor
• Sentaurus Device
• Output examples

✓ Conclusion
Conclusions (1)

• Synopsys Sentaurus TCAD is the most developed software package for TCAD simulations, in fact it is the industry-standard

• It is a software suite, that is it contains several dedicated tools, each of them having its own programming language

• Among the tools, the Sentaurus Workbench is the gateway that enables the control of all the simulation flow
Conclusions (2)

- Flow of a DEVICE TCAD simulation:
  - creation of a geometry and of the numerical mesh
    creating a numerical mesh for convergence cannot be trivial, frequently involving a trial-and-error procedure (trade-off between convergence/accuracy and simulation time)
  - choice of the physical models to be solved, of boundary conditions and material parameters
    which are the approximation inherent in the applied models? Are they acceptable? Should we include additional physics?
  - tweak of numerical parameters to assure convergence of numerical solution
    as for numerical mesh, mainly based on trial and error/experience
  - understands the output of the simulation
    Which is, in essence, the results of the simulation? How things can be changed for better performance/ to obtained the desired results?